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Prva stvar koju bi željeli uraditi u Ubunt-u je naštimati jželjeni jezik i tastaturu. Jezik koji instalirate 
također može poslužiti za provjeru spelovanja i gramatičkih grešaka u nekim aplikacijama. Da bi dodali 
jezike treba nam konekcija na internet, zato što se paketi sa jezicima trebaju skinuti sa Ubuntu servera. U 
sljedećoj vježbi ćemo se upoznati kako se konektovati na wirles mrežu. Za sad je dovoljno da je računar 
priključen na mrežu putem mrežnog kabla. 

Vježba broj 1 - Štimanje jezika na sistemu 

Idemo na On/Off dugme na desnom gornjem čošku ekrana, ------> idemo na System Settings... ------> pa 
idemo na Language Support. U ovom dijelu nas može pitati da li trebamo skinuti pakete za jezike, i 
odgovorimo sa da i sačekajmo da se paketi skinu. Na vrhu ekrana imate listu instaliranih jezika i ovu listu 
možete prevuči-i-pustiti i napraviti poredak po svom ukusu. Jezik na vrhu ekrana će biti glavni jezik vašeg 
sistema. Ako izaberete novi jezi da bude defaultni (osnovni) trebate napraviti klik na Apply sistem widle, da 
bi napravili promjene na čitavom sistemu, a ne samo na trenutnom accountu. Da skinete više jezika kliknite 
na dugma Install/Remove languages... zatim kliknite na chackbox-ove jezika koje želite i idemo na Apply 
changes. Sljedeći put kad se logujete biće vam postavljeno pitanje da li ove promjene želite da se izvrše i na 
imena foldera kao My documents i Music folder. Ako prihvatite promjene primjetit ćete da će se samo 
prazni folderi preimenovati. Ako na primjer folder Documents nije prazan kreirat će se novi folder 
Dokumenti i stari folder će se sačuvati. Dobra je ideja da se ide na Home folder kopira sadržaj foldera, i 
izbriše ono što nam ne treba. 

Na tabu Regional Formats tabu izaberite format zapisa brojeva, datuma, i  currency i idemo na apply 
system widle. 

Sad izađemo iz sitema pomoću Log out i ponovo se logujemo da bi vidjeli željene postavke. 

 

Pored Ethatner mreže koja za konekciju koristi kablove, Ubuntu dolazi potpuno spreman za wifi mreže. 
Većini wifi kartica treba odgovarajući driver da bi radila, i da bi provjerili da li je sve instalirano kako treba 
idite na System settings > Additional drivers da bi vidjeli da li je sve u redu sa pravilim instaliranjem vaše 
wifi kartice. Ako je potrebno skinuti novi driver za vašu wifi karticu, trebaće vam pristup na internet putem 
kabla, prije nego što budete u mogućnosti koristiti wireless konekciju. 

Vježba broj 2 – Konekcija na wifi mrežu i pretraživanje web-a  

Ako vam driveri ne trebaju, vaš wifi vjerovatno već radi i možete vidjeti wireless ikonu na gornjem 
meniju vašeg desktopa. Samo kliknuti na to i vidjećete dostupne wifi mreže oko vas. Ako se vaša mreža ne 
pojavi, pogledajte pod opcijom “more networks” ili “connect to hidden networks” u slučaju da je vaša 



mreža sakrivena. Dalje kliknite na vašu mrežu, ukucajte password i spremni ste za polijetanje. Sistem vas 
može pitati da ukucate keyring password da bi da bi sačuvao vašu šifru na računaru, i na taj način ne bi 
morali kucati vašu wifi šifru svaki put kad uključite računar. U suprotnom, kad izaberete da se konektujete 
automatski sistem će vas pitati za vaš keyring password prije nego što pristupi konekciji. Da bi izbjegli 
kucanje vašeg kejring pasworda svaki put kad se logujete, idite na “Edit connections” koji se nalazi na 
mrežnom meniju, pa izaberite konekcije koje koristite i kliknite na edit. Na dnu ovog prozora uključite 
kvadratić pod imenom „Dostupno svim korisnicima“. 

Jednom kad uradite ovo, kliknite na firefox ikonu i uživajte. 

Neki dodaci (plug-in-ovi) nisu uključeni u sklopu FireFox zato što nespadaju u besplatan softver. Ovi 
dodaci su nam potrebni da bi gledali flash video, animacije ili prilikom korištenja web aplikacija. Ako su vam 
potrebni neki od ovih dodataka, trebali bi omogučiti “multiverse” za kod softvera. U sljedećoj vježbi ćemo 
vidjeti kako ovo uraditi. Poslije instalacije novih dodataka (plug-in-ova) potrebno je zatvoriti pa ponovo 
pokrenuti FireFow. Postoji veliki broj dodataka koji su dostupni preko Firefokx meni tools > Add-ones 

U sljdećoj vježbi želimo da objasnimo kako instalirati novi softver na Ubuntu. 

 

Instaliranje novog softvera na Ubuntu nije komplikovano, ali možda je malo drugačije od onoga na koji 
ste navikli, pa obratite pažnju na ovu vježbu, može biti vrlo korisna. 

Vježba broj 3 – Instaliranje novog softwera  

Na Ubuntuu imate nešto što se zove softver centar koji se po defaultu nalazi na unity launcher-u (na 
lijevoj traci ekrana). Softwer centar je mjesto gdje ćete pronači hiljade aplikacija koje su spremne za 
instaliranje na vaš sistem. One su obično testirane i preuređene pomoću Canonical ili pomoću Ubuntu 
zajednice. Možete ili surfati kroz kategorije ili iskucati šta želite pronaći. 

Kad pronađete nešto interesantno, kliknite na njenu liniju i instalirajte. Napišite svoj password i 
sačekajte dok se ne instalira. Sad možet pronaći softwer koji ste upravo instalirali koristeći dash home 
(ikona sa Ubuntu logom na vrhu lijeve trake za pokretanje programa). Detaljnije ćemo objasniti kako 
pronaći fajlove, foldere i aplikacije u sljedećem videu. 

Ako ne možete vidjeti dugme za instaliranje opisano iznad, možete provjeritti kod softweraaa koji 
trenutno koristite. Po defaultu, Ubuntu će pretražiti Besplatan i Open Source Softver, ali bez obzira na ovo, 
možete instalirati softver koji želite. Ako niste upoznati sa idejom o besplatnom softveru, dosta toga 
možete naučiti korištenjem googla na mnogobrojnim webstranicama koje pričaju o tome, a mi bi izdvojili 
webstranicu idilix.net/arti (možda bi bilo lijepo i korisno da ovo pogledate). 

Da bi instalirali ograničeni softver ili softver koji je nečije vlasništvo, pokrenitie Softwere Centar i ideite 
na meni Edit > Software Sources poslije čega trebate napraviti klik na  “restricted” i “multiverse”. Sad ovu 
vrstu softvera možete instalirati koristeći Softver Centar. Dalje, da bi ste pustili ne-besplatni medija formate 
koa Windows media, Quicktime ili Flash, pretražite i instalirajte ubuntu-restricted-extras. Da bi mogli 
gledati zaštićene DVD-ove pritisnite Ctrl+Alt+T i onda ukucajte sljedeću naredbu  

sudo /usr/share/doc/libdvdread4/install-css.sh 



Ovo instaliranje softvera trebate uraditi samo jednom. Slobodno pogledajte stranicu 
https://help.ubuntu.com/community/RestrictedFormats za više informacija o ograničenim formatima i za 
razumjevanje zašto oni po defaultu nisu uključeni u Ubuntu. 

Također je moguće instalirati softver ručno, bez korištenja Softwer Centra, ali o tome nećemo pričati još. 
Za sad, Softwer centar će uraditi posao sasvim dobro. 

U sljdećoj vježbi želimo da vidimo kako pronaći fajlove, foldere i aplikacije na vašem računaru. 

 

Postoji više načina kako pronaći fajlove i foldere na Ubuntu desktopu. Najintuitivniji način je da idemo 
na Home folder koji se nalazi na lijevoj strani trake sa programima. Otvorit će se prozor koji na lijevoj strani 
ima imena foldera, a sadržaj foldera na desnoj strani, kao i kod većine operativnih sistema. Da bi podesili na 
koji način će se prikazivati podaci, idemo na View mani i izaberimo željeni izgled.  

Vježba broj 4 – Pronalaženje fajlova, foldera i aplikacija 

Da bi pronašli određen fajl ili folder možemo kliknuti na lupu koja se nalazi u desnom gornjem čošku 
otvorenog prozora i onda ukucamo šta tražimo. Pretraga će se vršiti u trenutnom folderu ali možemo 
lagano promjeniti ovo birajući sa padajućeg menija nešto drugo i pravljenju reload search. Možemo izabrati 
vrstu fajla koju tražimo klikajući na + dugme i birajući vrstu fajla koju tražimo. 

Postoje lakši i jednostavniji načini da pretražimo fajlove i foldere pomoću search opcije. Kliknite na Dash 
Home (logo Ubuntua) koja se nalazi na vrhu trake za pokretanje programa i izaberimo ključne riječi (npr. 
example). Dash home se može pokrenuti i klikanjem na win tipku (ili super tipku kako je neki nazivaju) koja 
se nalazi između lijevog ctrl i alt-a. Na dnu prozora sa pretrakom možete izabrati da li ste tražili aplikacije, 
fajlove, muziku ili video. Za svaku od njih na desnoj strani imate Filter koji će vam pomoći pri pregledu 
rezultata, tako što ćemo postaviti dodatno ograničenje kao vličina, datum, ocjena itd.  

Rezultati će biti prikazana u tri reda, sve i jedan u kratkom opisu. Potrebno je napraviti klik na opis da bi 
vidjeli sve rezultat. Da bi ste vidjeli rezultate u punom prozoru kliknite na Maximaze dugme u gornjem 
lijevom čošku prozora. Kliknite ponovo na isto dugme da se vratite na manji prozor. 

Nova opcija pod imenom Hadn display je predstavljena sa verzijom Ubuntu 12.04, koja nam dozvoljava 
da vršimo pretragu unutar sistema i system menija. Kao primjer, recimo da želimo promjeniti prikaz fajlova i 
foldera. Umjesto da idemo na View meni i biramo opciju List, možemo pritisniti alt i izabrati list. Meni opcija 
View > List će se prikazati i možete je izabrati pomoću strelica. Ovo je jednostavan primjer ali postoji i puno 
drugih složenijih i korisnijih primjera.  

 

Ubuntu dolazi sa mail klijentom integriranim unutar desktopa. Ovaj program je veoma sličan Microsoft 
Outlook-u na Windows OS ili Mail-u na Mac OS. Na traci koja se nalazi na vrhu ekrana , na desnoj gornjoj 
strani ekrana nalazi se mala sličica koverte koja će vas upozoriti na pristiglu poruku. Da bi podesili svoj mail 
klijent kliknite na tu kovertu i onda na Set Up Mail (naravno na ovo ćete klikniti ako je slučaj da ste prvi put 
pokrenuli softver, ili Mail i da prvi put koristiti Thunderbird na svojoj mašini).  Ako nije nikakav mail account 
podešen na Thunderbird-u, on će vam ponuditi mogućnost da kreirate novi account. Ovo možete preskočiti 
ako želite koristiti svoju postojeću e-mail adresu. Na configuration prozoru koji će se pojaviti, ukucajte svoje 
ime, e-mail i password, i tada kliknite na continue. Vaš e-mail informacije će se prikazati, i sve što treba je 
da podvrdite, i onda kliknite na „create account“. Da bi podesili neki drugi account idite na Thunderbird 
meni edit > account settings > account actions > add mail account. 

Vježba broj 5 – Provjera maila i podešavanje informacija o kontaktima  



Da bi uvezli kontakte, mailove ili ostale postavke iz nekog drugog klijenta, prvo exportujte infomacije sa 
svog starog mail klijenta. Instrukcije za ovaj korak (za eksport kontakata) zavisi od mail klijenta koji koristite. 
Poslije toga idite na Thunderbird meni Tools > Import i slijedite korake koji se pojave na vašem ekranu. 
Kontakti će onda biti dostupni klikom na Address Book dugme na gornjem Thunderbirds prozoru ili u 
„Contacts“ opciji na koverta meniju. 

Naravno, pristup e-mejlu i dalje možete koristiti na običan način putem Firefox-a.  

Sljedeća vježba je kako podesiti chat accounts (profil za komunikaciju). 

 

Klijenti (programi) za komunikaciju 

Vježba broj 6 – Chat client (MSN, Google talk, IRC, Facebook...)  

Ubuntu je totalno spreman za najpopularnije chat servise direktno sa vašeg desktopa. Lociran je na 
istom meniju koji smo koristili u prethodnoj vježbi, koverta na na meniju u vrhu prozora. Ovaj put trebamo 
kliknuti na Chat u sklopu koverta (envelope) menija. Kao i kod konfigurisanja vašeg mail klijenta, pojavit će 
se prozor da vas vodi kroz ostatak podešavanja vašeg chat računa. Ono što je potrebno je da ste 
registrovani na nekom od chat servisa kao MSN, Google chat ili Facebook chat prije nego što možete 
konfigurisati svoj chat klijent. Izaberite račun koji želite podesiti, ukucajte svoje ime i password i već ste 
spremni za primanje i slanje chat poruka. Za pristigle poruke ćete također biti obavješteni preko koverat 
ikone. U istom koverat (envelope) meniju možete podesiti svoje trenutno stanje koje će biti prikazano na 
vašem kontaktu. 

U vježbi broj tri iz trećeg dijla lekcija iz Linuksa, ćete vidjeti da Chat klijent možete koristiti da bi 
kontaktirali ljude iz Ubuntu zajednice. Postoji mnogo soba za pričanje za Ubuntu, uključujući i početničku 
sovu gdje možete postavljati pitanja i odmah dobiti odgovor od nekog drugog konektovanog korisnika. 
Pokušajmo prvo preći sve vježbe iz ovih lekcija pa tek onda koristiti IRC sobe za pričanje u slobodno vrijeme. 

U sljdećoj vježbi ćemo pričati o Free i Open Source office paketu koji se zove Libre Office. 

 

Najpopularnije kancelarijske aplikacije uključene u Ubuntu OS već imaju napravljenu prečicu na lijevoj 
traci sa alatima (poznata pod imenom unitiy launcher) po defaultu. Tu možete vidjeti text editor LibreOffice 
Writer (koji je po mogućnostima i načinu rada isti kao Word na Windowsu ili Pages na Mac-u), program za 
rad sa tabelama LibreOffice Calc (ekvivalentan sa Excellom na Windowsu ili Numbers na Mac-u) i program 
za pravljenje prezentacija LibreOffice Impress (koji odgovara PowerPointu na Windows-u ili Keynote-u na 
Mac-u). Samo napravite klik, i počnite praviti željeni dokument. LibreOffice je potpuni kancelariski paket i 
radi skoro isto kao i svi ostali kancelariski paketi, u slučaju da ste već upoznati sa radom tih nekih drugih 
paketa, neće vam trebati ni malo vremena da se uštimate sa ovim programom. Usput, napomenimo i to da 
je LibreOffice dostupan i na Windowsu i na Macu. Ostale kancelariske aplikacije mogu biti skinuti sa softver 
centra: LibreOffice Math, LibreOffice Draw, LibreOffice Base, Dictionaries, Sticky Notes, Organizers, Finance 
managers, Printer and scanner drivers i puno više. Da bi saznali puno više kako koristiti programe iz 
LibreOffice paketa, pogledajte oficijelnu LibreOffice dokumntacionu stranicu na adresi 
www.libreoffice.org/get-help/documentation/. 

Vježba broj 7 – Office suite  



Šljedeće što želimo je da vidimo kako pustiti muziku i filmove. 

 

Da bi ste uživali u svojoj digitalnoj kolekciji, trebate otići na ikonu zvučnika na gornjoj traci i pokrenuti 
Rhythmbox. 

Vježba broj 8 – Puštanje muzike i videa  

Rhythmbox je podpun medija player rješenje sa mnogim dodacima kao internet radio, on-line muzička 
radnja, play liste, ocjene pjesama, audio format konversija, mp3 player ili iPod menađer i puno više. Da bi 
ste uvezli fajlove ili foldere u svoju biblioteku, idite na meni Music>Import file ili Import folder. U zadnjih 
nekoliko verzija Ubuntua, defaultni media player je bio Banshee. Iako je napravljena odluka da se pređe na 
Rythmbox, i dalje možete skinuti sa interneta i koristiti Banshee, ako želiite. 

Ako preferirate nešto slično Winamp-u, pokušajte sa Audacious ili Amarok, oba su visoko kvalitetna dva 
softvera, dostupna iz softwere centra, i besplatna za korištenje. 

U slučaju da želite slušati samo jednu pjesmu ili gledati samo jedan film, bez dodavanja u vašu medija 
kolekciju, ovo možete bez problema uraditi putem Totem medija playera. Ovo je vrlo jednostavan softwer, 
koji će samo pročitati vaš medija fajli i zaustaviti se. Da bi pokrenuli Totem movie player idite na Dash home 
i upišite totem ili movie player. Poslije toga idite na meni movie>open i izaberite film ili pjesmu koju želite 
pustiti. Također možete prevući i pustiti medija fajl na Totem i to će raditi također. Totem čita veliki broj 
audio i video formata, uključujući windows media file format .wmv, Applov iTunes format .m4v, besplatne 
formate kao .ogg ili .mvk, plus CD-ove, DVD-ove i BluRay. Kao drugu varijantu možete koristi VLC koji je 
drugi popularni Besplatni i Open Source Software za čitanje medija fajlova. 

Sljedeća vježba je namjenjena za organizovanje i uživanje u vašim slikama i fotografijama. 

 

Upravljanjem slikama je omogućeno preko Shotwell. Ovaj program je vrlo sličan Windows photo galery-
ju, Picasi ili iPhoto, koji nam omogućavaju da importujemo i organizujemo naše slike. Da bi pronašli ovaj 
program trebamo kucati shotwell na Dash-u (logo ubuntua) ili search aplications i koristiti filter za grafičke 
aplikacije. Shotwell može importovati slike preko vašeg računara, nekog vanjskog diska ili direktno preko 
vašeg fotoaparata. Kad prikopčate fotoaparat pojavit će se prozor koji će vas pitati šta treba uraditi. Ovdje 
možete izabrati opciju da treba otvorit Shotwell. Poslije toga trebate napraviti samo jedan klik da bi ste 
importovali slike.  

Vježba broj 9 – Fotografije i slike 

Prvi put kad pokrenete ovaj program sistem će vam pomoći da organizujete vaše fotografije. Poslije 
importovanja vaših slika, možete lagano im dati ocjene, odbaciti ih, vidjeti po datumima i slično. Glavne 
opcije možete dobiti ako napravite klik sa desnim dugmetom, ali puno više opcija ćete dobiti birajući meni 
na vrhu. Ako želite samo pogledati slike ali ne i dodati ih u svoj Album, potrebno je napraviti samo dva klika 
na slikui sistem će je prikazati. Ovo je integrirano u sistem tako da ne morate raditi ništa posebno. Radi kao 
što ste i očekivali.  

 



Pravljenje beckup-a (arhive) svojih podataka je od esencijalne važnosti za prevenciju gubitka podataka. 
Uvijek treba praviti beckup i osigurati se da je gubitak podataka minimalan. Važno je da pravimo beckup na 
neki vanjski disk, zato što, ako vam se vaš (unutrašnji) hard disk pokvari imat ćete podatke na tom 
vanjskom. 

Vježba broj 10 - Beckup 

Pa priključimo vanjski disk i pokrenite backup aplikaciju klikanjem na Ubuntu logo -> u search boxu 
ukucamo backup. Isto tako aplikaciju možemo pokrenuti sa System settingsa: On/Off -> System settings -----
-> Beckup 

Ako je ovo prvi put da pokrećete Beckup dobićete opciju da povratite podatke sa nekig ranijeg beckupa 
ili da vidite trenutne postavke. Kliknite ne Just show my beckup settings pa uključite automatic beckup 
prekidač. Ovo će vam osigurati da će se beckup raditi bez vaše brige o tome. Ako se iz nekog razloga desi 
slučaj da Ubuntu ne mogne napraviti arhivu automatski, bićete obavješteni o tome. Na tabu Storage 
izaberite Backup Lokaciju. Ako koristite vanjski disku uključite Local folder (sa padajuće liste) pa onda 
izaberite folder na svom vanjskom disku u koji želite snimati svoju arhivu. Ovo je najlakši način za pravljenje 
beckupa i postoje i drugi oblici kao snimanje podataka u oblaku na nekom od Ubuntu servera (biranjem 
postavke Ubuntu one), na nekom od ftp servera ili na nekom od webDav servera. Ubuntu nam dozvoljava 
da koristimo do 5 GB podataka. Nekad se dešava da beckup pređe preko ovog praga i moguće je kupiti 
dodatni prostor. 

Na Folder tabu možemo uključiti ili isključiti nešto željene filove ili foldere koji će ući u beckup. Defaultne 
postavke će biti dovoljne za većinu korisnika. I konačno na zadnjem tabu Schaulder izaberite koliko često 
želite praviti beckup i koliko dugo ćete držati beckup. Stari beckup će se čuvati do naznačenog vremena ili 
dok se ne potroši slobodan prostor potreban za beckup. 

Da bi povratili informacije iz svog beckupa, pokrenimo dati softver i ovaj put izaberimo Restore sa 
Overview taba.  


